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Trademarks 

© 2015 Plustek Inc. All rights are reserved. No portion of this document may be 

reproduced without permission.  

All trademarks and brand names mentioned in this publication are property of 

their respective owners. 

Liability 

While all efforts have been made to ensure the accuracy of all contents in this 

manual, we assume no liability for errors or omissions or by statements of any 

kind in this manual, whether such errors are omissions or statements resulting 

from negligence, accidents, or any other cause. The contents of this manual are 

subject to change without notice. We will not shoulder any legal liability, if users 

failed to follow the operation instructions in this manual. 

Copyright 

The scanning of certain documents, for example checks, bank notes, I.D. cards, 

government bonds, or public documents, may be prohibited by law and/or subject 

to criminal prosecution. We recommend you to be responsible and respectful of 

the copyrights laws when you are scanning books, magazines, journals and other 

materials. 

Environmental Information 

Recycle or disposal at end-of-life information, please ask local distributors or 

suppliers for recycle and disposal information. The product is designed and 

produced to achieve sustainable environmental improvement. We strive to 

produce products in compliance with global environmental standards. Please 

consult your local authorities for proper disposal. 

The product packaging is recyclable. 

Attention for recycling (For EU country only) 

Protect your environment! This product should not be thrown into the household 

waste container. Please give it to the free collecting center in your community. 

Screen Examples in This Manual 

The screen shots in this guide were made with Windows 7. If you are using 

Windows XP / Vista / 8, your screen will look somewhat different but functions the 

same. 
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INTRODUCTION 
Thank you for choosing us as your scanner supplier. Your new scanner will 

improve the professionalism of your day-to-day computing tasks by allowing you to 

input images and electronic text into your computer system. You can easily scan 

single-sided or double-sided documents with your scanner. 

Like all of our products, your new scanner is thoroughly tested and backed by our 

reputation for unsurpassed dependability and customer satisfaction. We hope you will 

continue to turn to us for additional quality products as your computing needs and 

interests grow. 

HOW TO USE THIS GUIDE 

This User’s Guide provides instructions and illustrations on how to install and 

operate your scanner. This guide assumes the user is familiar with Microsoft Windows. 

If this is not the case, we suggest you learn more about Microsoft Windows by 

referring to your Microsoft Windows manual before using your scanner.  

The Introduction section of this manual describes the box contents and minimum 

computer requirements to use this scanner. Before you start installing your scanner, 

check the box contents to make sure all parts are included. If any items are damaged 

or missing, please contact the vendor where you purchased your scanner or our 

customer service directly. 

Chapter I describes how to install scanner’s software and connect the scanner to 
your computer. Note: The scanner connects to your computer through the Universal 

Serial Bus (USB). If your computer does not support USB technology, you will need to 

purchase a USB interface card to add USB capabilities to your computer, or buy and 

install USB connectors if your motherboard has USB capabilities. This guide assumes 

that your computer is USB-ready and has a free USB port. 

Chapter II describes how to use your scanner. 

Chapter III describes how to maintain and clean your scanner. 

Chapter IV contains technical support information that can help you solve simple 

problems. 

Appendix A contains the specifications of the scanner you purchased. 

Appendix B contains our customer service, the limited warranty agreement and 

FCC statement concerning the product. 
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CONVENTIONS OF THIS GUIDE 

Bold — Represents commands or contents on your computer screen. 

ALL CAPS — Important note or first use of an important term in a chapter. 

Italic — Represents buttons on your scanner OR important notes. 

AA  NNoottee  aabboouutt  IIccoonnss  

This guide uses the following icons to point out information that deserves special 

attention. 

 

Warning 

A procedure that must be followed carefully to prevent injury, 

or accidents. 

 

Attention 

Instructions that are important to remember and may prevent 

mistakes. 

 

Information 

Optional tips for your reference. 

SAFETY PRECAUTIONS 

 

Warning 

Before using this device, please read the 

following important information to eliminate or 

reduce any possibility of causing damage and 

personal injury. 

1. Usage, the product is for indoor use in dry locations. Moisture condensation may 

occur inside this device and cause malfunction at these conditions: 

 when this device is moved directly from a cold to a warm location; 

 after a cold room is heated; 

 when this device is placed in a damp room. 

To avoid the moisture condensation, you are recommended to follow the 

procedure: 

i. Seal this device in a plastic bag for it to adapt to room conditions. 

ii. Wait for 1-2 hours before removing this device from the bag. 

2. Do use the AC adapter and USB cable provided with the scanner. Use of other 

AC adapter and cables may lead to malfunction. 
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3. Keep the space around the AC adapter clear in case you need to quickly unplug 

the AC adapter during emergencies. 

4. Damaged wire could cause fire or electrical shock. Keep the power cord straight 

and without being twisted, bended, or scraped. 

5. Unplug this device if you don’t need to use for a certain period of time, such as, 
during night or long weekend, to avoid any risks of causing fire. 

6. Do not attempt to disassemble the scanner. There is danger of an electrical shock 

and opening your scanner will void your warranty.  

7. Be sure not to bump or knock the scanner glass as it is fragile and could break. 

8. Do not subject the scanner to excessive vibration. It may damage the internal 

components. 

MINIMUM SYSTEM REQUIREMENTS
1 

 PC with Intel Pentium
®
 IV 2.0 GHz processor or compatible 

 1 GB RAM 

 Available USB 2.0 port 

 CD-ROM Drive 

 800 MB Free Hard Disk Space 

 Operating System: Windows XP / Vista / 7 / 8 

 

Information 

Systems with Pentium
®
 IV 3.0 GHz or higher 

processor (or its compatible) and 1 GB free hard 

disk space are recommended for optimal 

performance. 

                                                
1
 Higher requirements may be needed when scanning or editing large quantities of images. The 

system requirements stated are only a guideline, generally the better the computer (motherboard, 
processor, hard disk, RAM, video graphic card), the better the results. 
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BOX CONTENTS
2 

 

1. Scanner 

2. USB Cable & Ethernet Cable 

3. AC Adapter 

4. Quick Guide  

5. Setup/Application CD-ROM 

6. Calibration Sheet  

7. Cleansing Cloth  

8. Pad Module 

                                                
2
 Save the box and packing materials in case you need to transport this scanner in the future. 
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SCANNER OVERVIEW 

 

1. ADF (AUTOMATIC DOCUMENT FEEDER)—Automatically feeds a stack of 

documents for scanning. 

2. PAPER WIDTH SLIDER—Adjusts the paper width slider for the paper size you 

are using. 

3. SCAN BUTTON—Press to perform a predefined scanning task.  

4. PDF BUTTON—Press this button to scan documents into PDF files.  

5. POWER LED—Indicates the scanner status.  

Light Status 

Blue The scanner is turned on, ready to scan images. 

Orange 
The scanner is in standby mode (sleep mode) if it is idle for 10 

minutes. 

Off 

The scanner is off, either because the power is not turned on, or 

because the AC adapter is not properly plugged into an AC 

power outlet. 

6. CUSTOM BUTTON—Press to perform a predefined scanning task.  
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7. POWER SWITCH—Use this to turn the scanner ON or OFF. 

8. USB PORT—Connects the scanner to a USB port on the computer by the 

included USB cable. 

9. ETHERNET PORT—Connects the scanner to a port on the Ethernet hub by the 

included Ethernet cable. 

10. RESET BUTTON—Resets the scanner’s network settings to its factory default 

setting. Stab the RESET button with a pin for several seconds to reset the 

scanner’s network settings. The scanner’s default IP address is 169.254.10.10, 
the Subnet Mask is 255.255.0.0. 

11. POWER RECEPTOR—Connects the scanner to a standard AC power outlet by 

the included AC adapter. 

 

12. DOCUMENT COVER— Helps keep the paper in place and protects the scanner 

glass. 

13. DOCUMENT PAD— Keeps the paper in place and improves accuracy of image 

quality. 

14. REFERENCE MARK— Align your paper with this reference mark in case of 

flatbed scanning.  

15. SCANNER GLASS— Where you put items for flatbed scanning. 
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CHAPTER I. INSTALLING THE SCANNER 
Before installing your scanner, please verify that you have all of the proper 

components. A list of the package contents is provided in the “Box Contents” section of 
this guide.  

SOFTWARE INSTALLATION REQUIREMENTS 

Your scanner comes with OCR software (ABBYY FineReader Sprint), document 

management software (NewSoft Presto! PageManager), the scanner’s driver and 

DocAction. All of these software applications use approximately 800 megabytes of 

hard disk space after they are installed into your computer. To ensure ample room for 

the installation, as well as for scanning and saving images, a minimum of 1 GB of hard 

disk space is recommended. 

This USB scanner can only operate under the Microsoft Windows XP / Vista / 7 / 

8 operating system. 

HARDWARE REQUIREMENTS  

This scanner connects to your computer through the Universal Serial Bus (USB), 

which supports HOT PLUG AND PLAY. To determine whether your computer is USB-

capable, you must check the rear of your PC to locate a USB jack that looks like the 

picture below. If you are having trouble in locating the USB port on your computer, 

please refer to the hardware manual that came with your computer.  

Upon examination, you should find one or two rectangular USB ports, which 

usually appear as shown below. 

            

If you don’t find such USB ports on your computer, then you need to purchase a 
certified USB interface card to add USB capabilities to your computer. 

USB Connector(s) 
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INSTALLING AND SETTING UP THE SCANNER 

Please follow the step-by-step procedures described below to install the Plustek 

scanner. 

 

Attention 

Choose a Proper Site First! 

 Always place your scanner on a level, 

smooth and strong surface before 

proceeding the scanner setup or any 

scanning task. Tilted or uneven surface may 

cause paper-feeding errors, scanner 

damage or personal injury. 

 Avoid using the scanner in a dusty 

environment. Dust particles and other 

foreign objects may damage the unit. 

SStteepp  11..  CCoonnnneeccttiinngg  tthhee  SSccaannnneerr  ttoo  YYoouurr  CCoommppuutteerr  

Using the USB Cable to connect the Scanner and Your Computer 

 

 

Attention 

Please make sure the scanner is turned OFF 

before you plug or unplug the scanner power 

adapter. 
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1. Plug the AC adapter into the scanner’s power receptor. 

2. Plug the other end of the AC adapter into a standard AC power outlet. 

3. Plug the square end of the included USB cable to the USB port  at the rear 

of the scanner. 

4. Plug the rectangular end of the USB cable to an available USB port on the 

computer. 

5. If you plan to connect your scanner to a USB hub
3
, make sure that the hub is 

connected to the USB port in your computer. Next, connect the scanner to the 

USB hub. 

Using the Ethernet Cable to connect the Scanner and Your Computer 

 

 

Attention 

Please make sure the scanner is turned OFF 

before you plug or unplug the scanner power 

adapter. 

                                                
3
 The USB hub is not included with the scanner. 
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When you use the Ethernet cable to connect the scanner and your computer on 

the network, please do not connect the USB cable to the scanner at the same time. If 

you use both the USB cable and the Ethernet cable to connect the scanner and your 

computer, only the scanner USB port is working properly, but the function of the 

scanner Ethernet port will be disable. Please make sure to unplug the USB cable from 

the scanner when you use the Ethernet cable to connect the scanner and your 

computer. 

1. Plug the AC adapter into the scanner’s power receptor. 

2. Plug the other end of the AC adapter into a standard AC power outlet. 

3. Plug the end of the included Ethernet cable to the Ethernet port at the rear of the 

scanner.  

4. Plug the other end of the Ethernet cable to an available port on the Ethernet hub
4
.  

5. Plug the end of another Ethernet cable to the Ethernet port on the computer.  

6. Plug the other end of the Ethernet cable to an available port on the Ethernet hub. 

SStteepp  22..  IInnssttaalllliinngg  tthhee  SSooffttwwaarree  

1. Switch on the scanner power from the rear of the scanner. 

2. If the USB components on your computer are functioning correctly, they will 

automatically detect the scanner causing the Add New Hardware Wizard or 

Found New Hardware Wizard to be launched. 

 

Information 

If your computer is off when the scanner is 

connected, the “Add New Hardware Wizard” 
message will not be displayed until the computer 

is on and Windows starts. 

3. For Windows XP: 

a. Insert the Setup/Application CD-ROM, included with your scanner, into your 

CD-ROM drive. 

 

b. Select Install the software automatically recommended and click the Next 

button. 

c. Click the Next button in the window that appears. Afterwards, please skip to 

procedure 7. 

                                                
4
 The Ethernet hub is not included with the scanner.  
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4. For Windows Vista: 

a. Select “Locate and install driver software (recommended)” when the “Found 
New Hardware” window is displayed. 

b. Click on the Continue button when the “User Account Control” dialog pops up. 

c. Insert the Setup/Application CD-ROM, included with your scanner, into your 

CD-ROM drive when the system prompts you “Insert the disc that came with 
your USB Scanner“, and click on the Next button. Afterwards, please skip to 

procedure 8. 

5. For Windows 7: 

When the Setup/Application CD is for several scanner models 

a. Insert the Setup/Application CD-ROM, included with your scanner, into your 

CD-ROM drive. Click Run install.exe in the AutoPlay window. 

b. Click on the Yes button if the User Account Control dialog pops up. Follow 

the instructions in the pop-up installation message. 

c.  In the Device Manager window, right-click on this scanner under Other 

devices and select Update Driver Software from the pop-up menu. Click 

Browse my computer for driver software in the window that appears, and 

click the Browse button.  

d. In the Browse For Folder window, select the folder or the CD-ROM drive that 

contains this scanner’s driver and click the OK button to return to the previous 

screen. Click the Next button and click Install this driver software anyway if 

the Windows Security window appears. Afterwards, please skip to procedure 

9. 

When the Setup/Application CD is for one scanner model 

a. Insert the Setup/Application CD-ROM, included with your scanner, into your 

CD-ROM drive. Click on the pop-up notification, then click Run install.exe in 

the pop-up window. If you miss the pop-up notification, please eject and re-

insert the Setup/Application CD-ROM. 

b. Click on the Yes button if the User Account Control dialog pops up. 

Afterwards, please skip to procedure 9. 

6. For Windows 8: 

a. Insert the Setup/Application CD-ROM, included with your scanner, into your 

CD-ROM drive. Click Run install.exe in the AutoPlay window. 

b. Click on the Yes button if the User Account Control dialog pops up. 

Afterwards, please skip to procedure 9. 
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7. During the process of the installation, a message “Windows can’t verify the 
publisher of this driver software” might be prompted. Please ignore it, and click on 

[Install this driver software anyway] to continue the installation without any 

misgiving at your scanner functioning. 

8. When the system completes the installation, click the Finish button. 

9. Follow the on-screen instructions to install all software that your new scanner 

requires. If the pop-up wizard window appears click Next, and click Install this 

driver software anyway in the Windows Security window then click Finish in 

the wizard window. 
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10. Select the method to connect the scanner and your computer. 

Using the USB cable to connect the scanner and your computer  

a. Select the USB Port Connection option. Follow the on-screen installation 

instructions. Afterwards, please skip to procedure 11. 

 

Using the Ethernet cable to connect the scanner and your computer in a network 

environment with a DHCP server 

a. Select the Ethernet Port Connection option. Please make sure to unplug the 

USB cable from the scanner when you choose this option.  
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b. Follow the on-screen installation instructions. Please use the Scanner Search 

Tool to search available scanners and select the desired scanner to be used, 

and then click Connect Device button to make connection. (If the Windows 

Security Alert window appears during the search tool execution, please 

unblock the search tool from the firewall to make sure the connecting process 

is working properly.) Refer to the online help of Scanner Search Tool to 

explorer more about Scanner Search Tool! 

 

 

c. After you make sure the Scanner Search Tool is working properly and the 

scanner connection status indicates Locally Connected, please click the OK 

button to confirm the status and start the scanner calibration process. 

Afterwards, please skip to procedure 12. 
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Using the Ethernet cable to connect the scanner and your computer in a network 

environment with static IP allocation 

a. Disconnect your computer from your network environment by unplugging the 

network cable from your computer. Connect the scanner and your computer 

using an Ethernet cable. 

b. Select the Ethernet Port Connection option. Please make sure to unplug the 

USB cable from the scanner when you choose this option.  

 

c. Follow the on-screen installation instructions. Please use the Scanner Search 

Tool to search available scanners. (If the Windows Security Alert window 

appears during the search tool execution, please unblock the search tool from 

the firewall to make sure the connecting process is working properly.) Refer to 

the online help of Scanner Search Tool to explorer more about Scanner 

Search Tool! 

d. Select the desired server icon  in the scanner list. Click Server 

Configurations from the Options menu. Untick the Use DHCP option and 

modify the IP Address and Subnet to match your network environment. 

Please consult your network administrator for the IP Address and Subnet. 

Please make sure that the setting is valid and correct. Do not enter an IP 

address that already exists in the network. Click the Set button to save 

settings. 
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e. Unplug the network cable from the scanner and your computer. Plug the end 

of the Ethernet cable from “step a” to the Ethernet port of your computer. Plug 

the end of another Ethernet cable to the Ethernet port at the rear of the 

scanner. Plug the other end of the Ethernet cable to an available port on the 

Ethernet hub. 

f. Please search available scanners again and select the desired scanner icon 

 to be used, and then click Connect Device button to make connection. 

 

g. After you make sure the Scanner Search Tool is working properly and the 

scanner connection status indicates Locally Connected, please click the OK 

button to confirm the status and start the scanner calibration process. 

Afterwards, please skip to procedure 12. 

11. After the software is installed, you will be prompted to perform the scanner 

calibration. 

12. Insert the special calibration sheet into the ADF of the scanner. 
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13. Follow the on-screen instructions to complete the scanner calibration. After the 

calibration is complete, click OK and then click Finish.  

 

 

14. After the installation is complete, close all open applications and click the Finish 

button to restart your computer. 

 

Attention 

 Save the Setup/Application CD in case you 

need to reinstall the driver and software in 

the future. 

 Save the Calibration Sheet in case you 

need to calibrate the scanner in the future. 



18 

SStteepp  33..  TTeessttiinngg  tthhee  SSccaannnneerr  

The following describes how you can check if the scanner is properly functioning 

with your computer and the scanning software by performing your first scan with our 

bundled application NewSoft Presto! PageManager. Before testing your scanner, 

double check to make sure that all connections are securely fastened. 

To test the flatbed scanning: 

1. Open the scanner's document cover. Place a document face down onto the 

scanner glass and align the document top with the  reference mark. 

 

2. Gently close the document cover. 

3. Click the Windows Start button to launch Presto! PageManager. (For Windows 

8.1 users: Point your mouse cursor to the upper or lower right corner of your 

screen to open the Charm bar. Click on the Start charm, then click on the 

downwards arrow button in the lower left corner of the screen. The Apps screen 

will be shown. Move your cursor to the right edge of the screen to scroll right until 

you find Presto! PageManager, and then click on Presto! PageManager.) 

4. (If you have only one scanner connected with your computer, please skip to Step 

5.) 

If you have more than one scanner or other imaging device installed on your 

computer: From the File menu, click Select Source and then choose this scanner 

as the default scanning source. 

5. Within Presto! PageManager, click File > Acquire Image Data. 

6. In the TWAIN window that opens, select Flatbed Reflective as the Scan Type. 

7. Click the Scan button. 

8. If an image appears on your screen, your scanner is working properly. 
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To test the ADF scanning: 

1. Load a document headfirst and face down into the ADF with the text side facing 

the paper chute. (For detailed instructions on loading paper into the ADF, please 

refer to the “Placing Documents” section.) 

 

2. Click the Windows Start button to launch Presto! PageManager. (For Windows 

8.1 users: Point your mouse cursor to the upper or lower right corner of your 

screen to open the Charm bar. Click on the Start charm, then click on the 

downwards arrow button in the lower left corner of the screen. The Apps screen 

will be shown. Move your cursor to the right edge of the screen to scroll right until 

you find Presto! PageManager, and then click on Presto! PageManager.) 

3. (If you have only one scanner connected with your computer, please skip to Step 

4.)  

If you have more than one scanner or other imaging device installed on your 

computer: From the File menu, click Select Source and then choose this scanner 

as the default scanning source. 

4. Within Presto! PageManager, click File > Acquire Image Data. 

5. Select ADF (Front Side) as the Scan Type within the TWAIN window. 

6. Click the Scan button. 

7. The document in the ADF paper chute should be now loaded into the ADF and 

scanned. After this process, you should see a scanned image of the document on 

your screen. 

8. Click Exit to exit the TWAIN window. 

INSTALLING ADDITIONAL SOFTWARE 

Your scanner is TWAIN compliant and functions with virtually all available TWAIN 

compatible software. If you purchase additional software to be used with your scanner, 

please make sure that it conforms to the TWAIN standard. 
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CHAPTER II. SCANNING 
Your scanner needs to be driven by certain type of software program. Since all 

documents or images (whether text or pictures) that are acquired from the scanner are 

treated by your computer as images, most scanning will probably be done from an 

image-editing program where you can view, edit, save and output the scanned images. 

An image-editing program has been bundled for your scanner on the included 

Setup/Application CD-ROM. It will allow you to alter and correct any scanned images 

by using a variety of filters, tools and effects.  

What about scanning text documents and editing them in a word processor? This 

is the role of Optical Character Recognition (OCR) software. OCR software converts 

the image files that are created from scanning text documents into text files that can be 

viewed, edited and saved by word processors. An OCR program has also been 

bundled on the included Setup/Application CD-ROM, and if you wish to use the 

scanner in this way you should install the OCR software that is included. 

The DocAction program, seamlessly integrating the operation of your scanner 

with your computer and other peripherals, provides a quick and convenient way to 

perform various scanning functions. With DocAction, you don't need to adjust settings 

every time you scan. Simply press any button on the scanner's front panel or click any 

scanning menu item of DocAction on the screen. The scanner starts to scan your 

paper documents and transfer them to your assigned destination. The destination can 

be a printer, your E-mail program, files on your disk drives, an image-editing program, 

etc. 

Please refer to the online help of each program to guide you through any 

questions you may have while scanning within that program. 

This chapter describes three important steps of scanner operations. Read them 

thoroughly and follow the instructions to ensure correct use and optimal scanner 

performance. 

Step 1. Preparing Documents 

Step 2. Placing Documents, Placing Business Cards 

Step 3. Scanning Documents 

PREPARING DOCUMENTS 

Proper document preparation prior to the scan can prevent paper feed errors and 

damages to the scanner. 

 Checking Document Conditions 

 Loosening Documents  
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CChheecckkiinngg  DDooccuummeenntt  CCoonnddiittiioonnss  

Make sure the size and ream weight of your documents are acceptable by the 

scanner. Refer to “Appendix A: Specifications” of this guide for more information. 

To scan multiple documents in a batch from the ADF can increase your work 

efficiency and make large scanning tasks easier. The ADF of this scanner accepts a 

variety of paper and stationery you may use in your daily work or personal life, such as: 

 Normal paper whose size and ream weight meet the requirements stated in 

“Appendix A: Specifications” of this guide. 

 Notched paper 

 Coated paper (e.g., brochure) 

 

Attention 

To prevent paper feeding errors and damages to 

the ADF unit, strictly follow the instructions 

below: 

 Remove all small objects e.g., paper clips, 

pins, staples or any other fasteners 

attached, before loading the paper into the 

ADF. 

 Make sure the paper is completely flat with 

no creased or curled corners. 

 Avoid scanning documents with pencil lead 

and newspaper clippings as they will make 

the ADF exposure glass and the inner ADF 

dirty. If you have to scan such paper, clean 

the scanner frequently (refer to “Chapter III. 

Care and Maintenance” of this guide for 
more information). 

 The paper for each batch scanned by ADF 

can be of the same or different weights. 

However, make sure the length of each 

scan batch is the same. 
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However, use the flatbed to manually scan documents if they meet any of the 

following conditions: 

 Paper lighter than 50 g/m
2
 (14 lb.) or heavier than 120 g/m

2
 (32 lb.) 

 Paper with clips or staples attached 

 Paper with inconsistent thickness, e.g., envelops 

 Paper with wrinkles, curls, folds, or tears 

 Paper with an odd (non-rectangular) shape 

 Tracing paper 

 Carbon paper, pressure sensitive paper, carbonless paper 

 Items other than paper, e.g., cloth, metal foil. 

 

Attention 

 DO NOT use the ADF to scan photographic 

sheets or particularly valuable document 

originals; wrinkles or other damages can 

happen in case of paper feeding errors.  

 DO NOT place paper with wet ink or 

correction fluid onto the flatbed glass or into 

the ADF. Wait few minutes for it to get dry. 

LLoooosseenniinngg  DDooccuummeennttss  ((ffoorr  AADDFF  SSccaann))  

Before loading documents into the ADF, loosen them as follows: 

1. Fan the documents so that no two pages are sticking together. 

2. Hold the documents upside down with both hands, and then gently push them 

onto a flat surface to align the edges of all documents. 

 

This will allow documents being fed into the ADF one at a time and prevent paper-

feeding errors. 
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PLACING DOCUMENTS 

UUssiinngg  tthhee  FFllaattbbeedd  

1. Open the scanner's document cover. 

2. Place a document face down onto the scanner glass and align the document 

top with the reference mark. 

 

3. Gently close the document cover. 

UUssiinngg  tthhee  AADDFF  

1. Load the documents, headfirst and face down, toward the center of the ADF 

paper chute and all the way into the ADF until touching the bottom.  

For single-sided scans, load the documents face down so that the side to be 

scanned faces towards the paper chute.  

For double-sided scans, load the desired page order of documents face down 

so that the side to be scanned faces towards the paper chute. 

 



24 

2. Adjust the paper width slider for the paper size you are using. The paper width 

slider should be gently touching both sides of the documents.  

 

 

Attention 

 DO NOT load more than 50 sheets of paper 

(70 g/m
2
, 18 lb.) to the ADF. 

 Paper scanned from the ADF must be a 

minimum of 9 x 5.08 cm (3.55” x 2”, W x L). 
 Make sure there are no gaps between the 

document stack and the paper-width slider; 

otherwise, the scanned images can be 

skewed. 

 Although the documents should be loaded 

firmly in place ensuring optimum scanning 

accuracy, they should never be wedged in 

so tightly that the process of feeding them 

through the scanner is strained. 

 Do not load additional paper into the ADF 

while the unit is feeding and scanning. 
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PLACING BUSINESS CARDS 

1. Vertically load the business cards, headfirst and face down, toward the center 

of the ADF and all the way into the ADF until touching the bottom. 

For single-sided scans, load the business cards face down.  

For double-sided scans, load the business cards in desired order. 

 

2. Adjust the paper width slider to the business card width. The paper width 

slider should be gently touching both sides of the business cards.  

 

Attention 

Don’t load more than 10 business cards in one 
batch. 
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SCANNING DOCUMENTS 

There are 3 different ways to operate the scanner: 

1. By acquiring images from the scanner through our TWAIN interface within 

any TWAIN-compliant application programs. 

2. By scanning from the buttons on the scanner front panel. 

3. By scanning from DocAction's Execute menu on the screen. 

The TWAIN interface and DocAction software is automatically installed to your 

system along with the scanner driver. 

 

Attention 

Before you start scanning, check the following: 

 The power of both your computer and 

scanner is turned on. 

 The icon  appears on the Windows 

system tray. 

 Paper is appropriately placed on the 

scanner flatbed glass or loaded into the 

ADF. 

 Close the ADF cover by pushing it back 

down until it snaps back into place. The 

scanner can not scan properly when the 

ADF cover is not closed. 

SSccaannnniinngg  vviiaa  TTWWAAIINN  IInntteerrffaaccee  

The TWAIN program is a very important piece of software that comes with your 

scanner. This program acts as an interface between the scanner hardware and the 

image-editing software you are using to view and edit images. The TWAIN program 

allows you to adjust a number of settings to define the quality of the scanned image. 

The following describes how you may use our bundled document management 

software (NewSoft Presto! PageManager) to scan via TWAIN interface. When you get 

familiar with the scanning, you may alternatively use other TWAIN compatible 

scanning program or image-editing application to do your scanning projects. 

Select the Scan Source: 

If you have more than one scanner or other imaging devices installed on your 

computer, you need to set this scanner as the default scanning source before you 

acquire TWAIN program. 

1. For Presto! PageManager: From the File menu, click Select Source. 

2. In the window that opens, choose this scanner and then click the OK button to 

set this scanner as the default scanning source. 
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Scan within NewSoft Presto! PageManager: 

1. Click the Windows Start button to launch Presto! PageManager. (For 

Windows 8.1 users: Point your mouse cursor to the upper or lower right corner 

of your screen to open the Charm bar. Click on the Start charm, then click on 

the downwards arrow button in the lower left corner of the screen. The Apps 

screen will be shown. Move your cursor to the right edge of the screen to scroll 

right until you find Presto! PageManager, and then click on Presto! 

PageManager.) 

2. Within Presto! PageManager, click File > Acquire Image Data. 

3. In the TWAIN window that opens, select Flatbed Reflective or ADF (Front 

Side) as the Scan Type if you want to scan single-sided documents, or select 

ADF (Duplex) to scan double-sided documents. 

 

4. Adjust the scanning settings. For ADF (Duplex) scan, you can tailor settings 

individually for front and rear sides of the documents. Click Front Side button 

to adjust the scanning settings of document front side and then click Rear Side 

button to adjust the scanning settings of document rear side.  
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You can enable the function of Merge Pages only when you select ADF 

(Duplex) as Scan type and Automatic Size as Page Size to output the scan 

images of both front and rear sides in one image. After the function of Merge 

Pages is enabled, you can make the selection of Horizontally to generate both 

front and rear image data horizontally in a joined image (the rear image will be 

placed at the right side next to the front image), or make the selection of 

Vertically to generate both front and rear image data vertically in a joined 

image (the rear image will be placed below the front image). 

5. Load one page of the document and click the Preview button. The scanned 

image should appear in the Preview Window. To define the margins and crop 

out sections of the image you don’t want scanned, use the mouse to click and 
drag the corners or sides of the scan area borders. Adjust the scan settings 

again if the preview image doesn’t satisfy your needs. 

6. Load all pages of the document and click the Scan button. 

7. When the scan finishes, click the Exit button to close the TWAIN window. The 

scanned images are displayed in Presto! PageManager, and you may perform 

the image editing tasks. 

Click the Help button within the TWAIN window for more information about the 

settings. 

SSccaannnniinngg  ffrroomm  tthhee  SSccaannnneerr’’ss  FFrroonntt  PPaanneell  oorr  OOnn--ssccrreeeenn  

DDooccAAccttiioonn''ss  EExxeeccuuttee  MMeennuu    

The settings for each button on the scanner's front panel are configured through 

DocAction. DocAction offers you quick access to the most frequently-used scanning 

functions. They are especially useful when you need to repeatedly scan with the same 

settings and send images to the same destination. 

Buttons on the scanner front panel will be used in this guide to demonstrate the 

scanner operations. You may also use DocAction's on-screen Execute menu to 

perform the same scanning tasks.  
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Configure Button Settings 

Before performing your first scan via scanner buttons, you are recommended to 

configure the button settings to your needs and preferences first. There are two ways 

to configure or view the button settings of DocAction: 

 Double-click the icon  in the Windows system tray. 

 Right-click the icon  in the Windows system tray, and then choose 

Button Configuration… in the pop-up menu that opens. 

Within the “Button Configuration” window, you can find a row of icons running 
through the left side of the window. Each icon corresponds to a single-touch button on 

your scanner's front panel (as well as DocAction's on-screen Execute menu). Clicking 

any icon on the left pane and its current button settings are displayed immediately on 

the right pane. You may adjust the settings as desired. 

Click the Help button within the Button Configuration window for more information 

about the settings. 

Scan Using the Buttons 

Scanning documents or images from this scanner is very easy. Follow the two 

steps described below: 

1. Place the document or images onto the scanner. (Refer to “Chapter II. 

Scanning” of this guide for more information in placing paper into the ADF or 
on the flatbed glass properly.) 

 

Attention 

Place only text documents for OCR purposes. 

Do not scan a photo using the OCR button. 

2. Do one of the following to start scanning: 

 Press the button from the scanner's front panel. 

 Right-click the icon  in the Windows system tray, and then choose 

Execute in the pop-up menu that opens. Click the desired button function 

item in the pop-up menu. 

The scanner starts to scan immediately and carry out the corresponding action 

according to the settings you have set up in the Button Configuration window. 
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CHAPTER III. CARE AND MAINTENANCE 
Your scanner is designed to be maintenance-free. However, constant care and 

maintenance can keep your scanner working smoothly. 

CLEANING THE SCANNER 

Paper powder, dust, ink and toner from paper being scanned may make the 

scanner glass and the inner ADF dirty, which leads to poor image quality or document-

feeding errors. How often to clean your scanner depends on the type of paper and 

number of pages being scanned. 

Perform the following procedures to clean the scanner surface, scanner glass and 

the ADF unit. Gently wipe locations described herein. Do not rub too hard. 

 

Warning 

 Before cleaning the scanner, turn off the 

scanner and disconnect the scanner’s 
power cable and USB cable, and then wait 

a few minutes for the glass and/or the inner 

ADF to cool to ambient temperature. 

 Wash your hands with soap and water after 

cleaning the scanner. 

CClleeaanniinngg  MMaatteerriiaallss  

Have the following cleaning materials ready to clean the scanner: 

 soft, dry, lint-free cloth (or a cotton swab) 

 non-abrasive cleaner—Isopropyl alcohol (95%). DO NOT use water. 

 

Attention 

 Alternatively you can use glass cleaner or 

neutral detergent for windows cleaning to 

clean the scanner glass. 

 However, DO NOT use either of them to 

clean the ADF feed roller or pad module. 

Use of other cleaning materials could damage your scanner. 
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CClleeaanniinngg  tthhee  FFllaattbbeedd  

1. Open the document cover. 

2. Gently wipe the following areas with the cloth dampened with the cleaner.  

Clean Document Pad & Scanner Glass: 

 

Clean ADF Exposure Glass: 
 

 
 

 

Attention 

Do not spray cleaner directly onto the scanner 

glass. Excess liquid residue may fog or damage 

the scanner. 

3. Wait for cleaned areas to dry completely. 

4. Gently close the document cover. 

Document 
Pad 

Scanner 
Glass 
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CClleeaanniinngg  tthhee  AADDFF  

1. Open the ADF cover by pulling the cover.  

 
 

2. Gently wipe the following areas with the cloth dampened with the cleaner. Be 

careful NOT to scratch their surfaces. 

Clean Feed Roller: 

Wipe the Feed Roller from side to side and then rotate it. Repeat this until its 

entire surface is cleaned. 

 

Clean Pad Module: 

Wipe the Pad Module from top to bottom (in the direction of arrow shown in 

below picture). Be careful not to damage the pick springs of the pad.  

 

ADF cover 
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Attention 

Do not spray cleaner directly onto the scanner 

glass. Excess liquid residue may fog or damage 

the scanner. 

3. Wait for cleaned areas to dry completely. 

4. Close the ADF cover by pushing it back down until it snaps back into place.  

 

REPLACING CONSUMABLES  

As a guideline, it is recommended to replace the pad module every 25000 sheets 

of scans.  

RReeppllaacciinngg  tthhee  PPaadd  MMoodduullee  

1. Open the ADF cover by pulling the cover.  

 

ADF cover 
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2. Remove the pad module by pinching both sides of the pad module and pull it 

out. 

 

3. Install the new pad module by inserting the tabs on the module onto their slots 

on the scanner.  

 

4. Close the ADF cover by pushing it back down until it snaps back into place. 
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CALIBRATING THE SCANNER 

Calibrate the scanner if colors appear in areas that should be white, or colors of 

the scanned image and the original vary a lot. This allows you to adjust and 

compensate for variations that can occur in the optical component over time by its 

nature.  

The following describes how to calibrate the scanner: 

1. The Calibration Sheet is used specially for ADF Scanning calibration.  

2. Insert the special calibration sheet into the ADF of the scanner. 

 

 

Attention 

Please insert the special calibration sheet 

included with the scanner. Alternatively you may 

also use any plain white sheet of paper sized in 

Letter/A4 instead; however, the calibration effect 

may be less good than the special calibration 

sheet. 

3. Click Start > All Programs > Your scanner model name > Calibration 

Wizard. (For Windows 8.1 users: Point your mouse cursor to the upper or 

lower right corner of your screen to open the Charm bar. Click on the Start 

charm, then click on the downwards arrow button in the lower left corner of the 

screen. The Apps screen will be shown. Move your cursor to the right edge of 

the screen to scroll right until you find Your scanner model name, and then 

click on Calibration Wizard.) 

4. Click Next from the Calibration Wizard that pops up and then click Calibrate 

Now.... Start to begin the Flatbed Reflective calibration process. After the 

calibration is complete, click OK. 

5. Click Calibrate Now.... Click on the Start button to begin the ADF calibration 

process. 

6. The scanner pulls the calibration sheet through the scanner, which completes 

this scanner calibration. After the calibration is complete, click OK and then 

click Finish. 
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STANDBY MODE 

To save power consumption, the scanner will enter the standby mode after it is 

idle for a while. You may disable the standby mode or define an idle time for the 

scanner to automatically enter the standby mode. 

1. From the Windows START menu, point to All Programs > Your Scanner 

Model Name, and then click Scanner Utility. (For Windows 8.1 users: Point 

your mouse cursor to the upper or lower right corner of your screen to open 

the Charm bar. Click on the Start charm, then click on the downwards arrow 

button in the lower left corner of the screen. The Apps screen will be shown. 

Move your cursor to the right edge of the screen to scroll right until you find 

Your scanner model name, and then click on Scanner Utility.) 

2. In the  section of the Scanner Utility window that opens, click 

the button of your option: 

a. To disable the Standby Mode: Click the button before Disable Standby 

Mode. 

b. To automatically enter the Standby Mode: Click the button before Enter 

the Standby mode after the scanner has been idle for ... minutes and 

then click the up or down arrows to set a default time for the scanner to 

automatically enter the Standby Mode. 

 

Information 

 The scanner will enter the standby mode 

(sleep mode)
 
after it is idle for 10 minutes.

 

Simply press any scanner button on the 

scanner panel and the scanner will return 

back to the normal status. 

 When you use the Ethernet cable to 

connect the scanner and your computer, 

please launch the Scanner Search Tool 

and click Search to wake up the scanner. 

Select the desired scanner to be used, and 

then click Connect Device button to make 

connection. 

3. Click on OK button to save settings and exit. 

 

Warning 

 To completely shut down the scanner, press 

the power switch on the side of the scanner. 

 If the scanner will not be used for a long 

period of time, shut down the scanner and 

then disconnect the power cable from the 

power outlet. 

Alternatively you may click Default to restore the default settings. You may press 

any scanner button to wake up the scanner from power saving. 
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CHAPTER IV. TROUBLESHOOTING 
If you encounter problems with your scanner, please review the installation and 

scanning instructions contained in this guide. 

Before you ask for customer service or repair, please refer to the information in 

this chapter and consult our FAQ (Frequently Asked Questions) in which you can find 

useful self troubleshooting information. From the Windows START menu, point to All 

Programs > Your Scanner Model Name, and then click FAQ. (For Windows 8.1 

users: Point your mouse cursor to the upper or lower right corner of your screen to 

open the Charm bar. Click on the Start charm, then click on the downwards arrow 

button in the lower left corner of the screen. The Apps screen will be shown. Move 

your cursor to the right edge of the screen to scroll right until you find Your scanner 

model name, and then click on FAQ.) 

SCANNER CONNECTION 

The first step to take when troubleshooting connection problems with your scanner 

is to check all physical connections. The icon , located on the Windows system 

tray, indicates if the scanner software is properly launched and the scanner and 

computer are communicating with each other. 

Appearance Status 

 

The program has been successfully launched, the scanner 

is connected with the computer and the scanner connection 

is activated, ready to scan images. 

 

The scanner is not connected with the computer, the 

scanner connection is not activated or the scanner power is 

not switched on. 

No Display 
You have chosen to terminate the program, no matter the 

scanner is connected or disconnected with the computer. 
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CLEARING PAPER JAMS 
If a paper jam in the ADF happens, please perform the following steps: 

1. Remove any unjammed documents still loaded into the ADF. 

2. Open the ADF cover by pulling the cover.  

 

3. Gently but firmly pull the jammed documents out of the ADF. Try to avoid 

creasing or wrinkling the documents. 

 

 

Attention 

Do not try to pull jammed or half-scanned 

documents out of the ADF without first opening 

the ADF cover. Doing so may permanently 

damage the ADF. 

4. Close the ADF cover by pushing it back down until it snaps back into place.  

 

ADF cover 
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APPENDIX A: SPECIFICATIONS
5 

 

Plustek SmartOffice PN2040 

Image Sensor CIS x 2 

Optical Resolution 600 dpi 

Hardware Resolution 
Flatbed: 600 x 1200 dpi 
ADF: 600 x 600 dpi 

ADF Capacity  

50 sheets (A4/ Letter, 70 g/㎡ or 18 Lbs), Max. 

thickness under 5mm (0.2"). 
Note: Maximum ADF capacity varies, depending upon 
paper weight. 

Scanning Speed ( ADF ) 

9 ppm/ 10 ipm (Color mode, 200 dpi, A4 Portrait) 
20 ppm/ 40 ipm (Grayscale mode, 200 dpi, A4 Portrait) 
20 ppm/ 40 ipm (B&W mode, 200 dpi, A4 Portrait) 
Note: Results may vary depending upon your scanning 
application, computer processor and system memory. 

Scanning Area (W x L) 

Flatbed: 
Max. 216 x 297 mm (8.5" x 11.69") 
Min. 12.7 x 12.7 mm (0.5" x 0.5") 
ADF: 
Max. 216 x 356 mm (8.5" x 14") 
Min. 13.2 x 13.2 mm (0.52" x 0.52") 

Acceptable Paper Sizes 
(W x L) 

Flatbed: 
Max. 216 x 297 mm (8.5” x 11.69”) 
Min. 12.7 x 12.7 mm (0.5” x 0.5”) 
ADF: 
Max. 220 x 356 mm (8.66” x 14”) 
Min. 90 x 50.8 mm (3.55” x 2”) 

Acceptable Paper Weight 
(Thickness) 

50 to 120 g/㎡ (14 to 32 Lbs) 

Daily Duty Scan ( Sheets ) 1,000 

Roller Lifetime (Scans)  100,000 

Pad Lifetime (Scans)  25,000 

Action Button Scan, PDF, Custom 

Power Supply 24 Vdc/ 0.75 A 

Interface USB 2.0 / RJ45 LAN 

Net Weight 3.78 Kgs (8.33 Lbs) 

Dimensions (W x D x H) 418 x 326 x 101 mm (16.45" x 12.83" x 4") 

Protocol TWAIN Compliant 

 

                                                
5
 Hardware specifications may change at any time without prior notice. 
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APPENDIX B: 
CUSTOMER SERVICE AND WARRANTY 
Visit our website www.plustek.com for more customer service information. For 

further assistance call our customer support phone number listed on the website. One 

of our representatives will be happy to assist you from Monday through Friday in office 

working hours. 

To avoid delays, please have the following information available before calling: 

 Scanner name and model number 

 Scanner serial number (Located at the bottom of the scanner) 

 Scanner CD version and part number 

 A detailed description of the problem 

 Your computer manufacturer and its model number 

 The speed of your CPU 

 Your current operating system and BIOS (optional) 

 Name of software package(s), version or release number and manufacturer of 

the software 

 Other USB devices installed 

SERVICE & SUPPORT INFORMATION 
Where appropriate, the period of availability of spare parts and the possibilities of 

upgrading products information. Please ask local distributors and suppliers for spare 

parts information and product upgrade information. 

Information requested by relevant Implementing Measure. Please ask local 

distributors and suppliers for the related information of Implementing Measure test 

report. 

Do not dispose anything of products before you ask local distributors and 

suppliers to get correct information for decreases of environmental impact with right 

methods and procedures. 

If you want to disposals the product and/or an accessory, please ask local 

distributors and suppliers to get the contact information of nearest disposal 

manufactures. 

If you have any maintenance inquiry, please ask local distributors and suppliers to 

get the contact information of nearest maintenance center in order to extend the 

product usage life time. 

If you want to maintain and clearance the product, please ask local distributors 

and suppliers to get the right information of nearest stores. 

http://www.plustek.com/
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STATEMENT OF LIMITED WARRANTY 

This Statement of Limited Warranty applies only to the options you originally 

purchase for your use, and not for resale, from an authorized reseller. 

The manufacturer warranty includes all parts and labor, and is not valid without 

the receipt of original purchase. To obtain warranty service, you may contact the 

authorized dealer or distributor, or visit our website to check out the available service 

information, or send a request via E-mail for further help. 

If you transfer this product to another user, warranty service is available to that 

user for the remainder of the warranty period. You should give your proof of purchase 

and this statement to that user. 

We warrant that this machine will be in good working order and will conform to its 

functional descriptions in the documentation provided. Upon provision of proof of 

purchase, replacement parts assume the remaining warranty of the parts they replace. 

Before presenting this product for warranty service, you must remove all 

programs, data and removable storage media. Products returned without guides and 

software will be replaced without guides and software. 

This Limited Warranty service does not provide for carry-in exchange when the 

problem results from accident, disaster, vandalism, misuse, abuse, unsuitable 

environment, program modification, another machine or non-vendor modification for 

this product. 

If this product is an optional feature, this Limited Warranty applies only when the 

feature is used in a machine for which it was designed. 

If you have any questions about your Limited Warranty, contact the approved 

retailer from whom you bought the product or the manufacturer. 

THIS LIMITED WARRANTY REPLACES ALL OTHER WARRANTIES, EXPRESS 

OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. HOWEVER, 

SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF 

THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE 

LIMITED IN DURATION TO THE WARRANTY PERIOD. NO OTHER WARRANTIES 

APPLY AFTER THAT PERIOD. 

Some jurisdictions do not allow limitations on how long an implied warranty lasts, 

so the above limitation may not apply. 

Under no circumstances are we liable for any of the following: 

1. Third party claims against you for losses or damages. 

2. Loss of, or damage to, your records or data; or 

3. Economic consequential damages (including lost profits or savings) or 

incidental damages, even if we are informed of their possibility. 
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Some jurisdictions do not allow the exclusion or limitations of incidental or 

consequential damages, so the above limitation or exclusion may not apply to you. 

This Limited Warranty gives you specific legal rights, and you may also have 

other rights that vary from jurisdiction to jurisdiction. 

FCC RADIO FREQUENCY STATEMENT 

This equipment has been tested and found to comply with the limits for a Class B 

digital device, pursuant to part 15 of the FCC rules. These limits are designed to 

provide reasonable protection against harmful interference in a residential installation. 

This equipment generates, uses and can radiate radio frequency energy and, if 

not installed and used in accordance with the instructions, may cause harmful 

interference to radio communications. However, there is no guarantee that interference 

will not occur in a particular television reception (which can be determined by turning 

the equipment off and on), the user is encouraged to try to correct the interference by 

one or more of the following measures: 

 Reorient or relocate the receiving antenna. 

 Increase the separation between the equipment and receiver. 

 Connect the equipment to an outlet on a circuit different from that which the 

receiver is connected. 

 Shielded interconnect cables and shielded power cord which are supplied with 

this equipment must be employed with this equipment to ensure compliance 

with the pertinent RF emission limits governing this device. 

 Consult the dealer or an experienced radio/TV technician for help if the 

conditions persist. 

 Changes or modifications not expressly approved by the manufacturer or 

authorized service center could void the user’s authority to operate this 
equipment. 

This device complies with Part 15 of the FCC Rules. Operation is subject to the 

following two conditions: (1) this device may not cause harmful interference, and (2) 

this device must accept any interference received, including interference that may 

cause undesired operation. 


